Software Manual

Waveform Composer Software R&S®AM 300-K2

Order No. 1147.2013.02
Software licence agreement

Rohde & Schwarz grants you the right to install the R&S Waveform Composer software on one or more PCs of your choice. The licence included in the software package is linked to 5 serial numbers of the arbitrary and function generators R&S AM300 selected by you, and allows you to transmit waveforms created with the R&S Waveform Composer software to those instruments. A further licence is required for each additional arbitrary and function generator R&S AM300 to which it is intended to transmit waveforms.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-6</td>
</tr>
<tr>
<td>1.1 Range of Applications</td>
<td>1-6</td>
</tr>
<tr>
<td>1.2 Accessories Supplied</td>
<td>1-6</td>
</tr>
<tr>
<td>2 Installation and Configuration</td>
<td>2-7</td>
</tr>
<tr>
<td>2.1 Installing the PC Software</td>
<td>2-7</td>
</tr>
<tr>
<td>2.2 Registering the PC Software</td>
<td>2-10</td>
</tr>
<tr>
<td>2.2.1 Requesting an Installation Key for the R&amp;S AM300</td>
<td>2-10</td>
</tr>
<tr>
<td>2.2.2 Enabling an Instrument</td>
<td>2-11</td>
</tr>
<tr>
<td>2.3 Starting the PC Software</td>
<td>2-14</td>
</tr>
<tr>
<td>2.3.1 Starting the Program</td>
<td>2-14</td>
</tr>
<tr>
<td>2.3.2 Closing the Program</td>
<td>2-14</td>
</tr>
<tr>
<td>2.4 Uninstalling the PC Software</td>
<td>2-15</td>
</tr>
<tr>
<td>3 Getting Started</td>
<td>3-16</td>
</tr>
<tr>
<td>3.1 Editing a Waveform</td>
<td>3-16</td>
</tr>
<tr>
<td>3.2 Editing a Segment</td>
<td>3-17</td>
</tr>
<tr>
<td>3.3 Editing a Component</td>
<td>3-18</td>
</tr>
<tr>
<td>3.3.1 Set Vector Format Parameters</td>
<td>3-18</td>
</tr>
<tr>
<td>3.3.2 Drawing in Draw Format</td>
<td>3-20</td>
</tr>
<tr>
<td>4 Operating Concept</td>
<td>4-21</td>
</tr>
<tr>
<td>4.1 Structure of the Program Interface</td>
<td>4-21</td>
</tr>
<tr>
<td>4.2 Selecting Functions</td>
<td>4-22</td>
</tr>
<tr>
<td>4.3 Overview of Functions</td>
<td>4-23</td>
</tr>
<tr>
<td>4.3.1 Pull Down Menus</td>
<td>4-23</td>
</tr>
<tr>
<td>4.3.2 Toolbar</td>
<td>4-24</td>
</tr>
<tr>
<td>5 Creating a Waveform</td>
<td>5-25</td>
</tr>
<tr>
<td>5.1 Waveform Parameters</td>
<td>5-25</td>
</tr>
<tr>
<td>5.1.1 Structure of a Waveform</td>
<td>5-25</td>
</tr>
<tr>
<td>5.1.2 Configuring a Waveform</td>
<td>5-26</td>
</tr>
<tr>
<td>5.1.2.1 Channel 1</td>
<td>5-26</td>
</tr>
<tr>
<td>5.1.2.2 Channel 2</td>
<td>5-27</td>
</tr>
</tbody>
</table>
## Contents

**5.1.2.3 Colours** ................................................................. 5-27
**5.1.2.4 Miscellaneous** ........................................................ 5-28
**5.1.3 Displaying the Parameters** ............................................. 5-29

**5.2 Segment Parameters** .......................................................... 5-30
**5.2.1 Structure of a Segment** ...................................................... 5-30
**5.2.2 New Segment** ............................................................... 5-30
**5.2.3 Displaying the Parameters** ................................................. 5-31
**5.2.4 Adapting the Samples** ...................................................... 5-32

**5.3 Component Parameters** ....................................................... 5-33
**5.3.1 Structure of a Component** ................................................... 5-33
**5.3.2 New Component** ............................................................ 5-33
**5.3.3 Displaying the Parameters** .................................................. 5-34
**5.3.4 Editing a Component** ........................................................ 5-35
**5.3.4.1 Standard Waveforms** ..................................................... 5-35
**5.3.4.2 Formula Waveform** ....................................................... 5-36
**5.3.4.3 Draw Waveform** ......................................................... 5-38

**6 Editing Data (File)** ................................................................. 6-39

**6.1 Internal File Format** ............................................................. 6-39

**6.2 Managing Data** ................................................................. 6-40
**6.2.1 New** ........................................................................... 6-40
**6.2.2 Open** ......................................................................... 6-40
**6.2.3 Save** ........................................................................... 6-40
**6.2.4 Save As** ........................................................................ 6-40
**6.2.5 File Information** ............................................................. 6-40

**6.3 Printing Data** .................................................................... 6-41
**6.3.1 Page Setup** ................................................................... 6-41
**6.3.2 Print Window** ................................................................. 6-41

**7 Editing a Waveform (Edit)** .................................................... 7-42

**7.1 General Functions** ............................................................. 7-42
**7.1.1 Cut** ............................................................................... 7-42
**7.1.2 Copy** ............................................................................ 7-42
**7.1.3 Paste** ........................................................................... 7-43
**7.1.4 Delete** .......................................................................... 7-43
**7.1.5 Clear Clipboard** .............................................................. 7-43

**7.2 Specific Functions** ............................................................... 7-43
**7.2.1 New Segment** ............................................................... 7-43
**7.2.2 New Component** ............................................................ 7-43
**7.2.3 Converting Formats** ........................................................ 7-44
**7.2.3.1 Waveform to Point** ...................................................... 7-44
**7.2.3.2 Segment to Point** ......................................................... 7-44
**7.2.3.3 Component to Point** .................................................... 7-44

**7.3 External File Formats** ........................................................ 7-45
7.3.1 Description ................................................................. 7-45
7.3.2 Import ......................................................................... 7-49
7.3.3 Export ......................................................................... 7-52

8 Adapting the Active Window (View) .................................. 8-53

8.1 Displays ............................................................................... 8-53
8.1.1 Display 1 ......................................................................... 8-53
8.1.2 Display 2 ......................................................................... 8-53
8.1.3 Display 1&2 ...................................................................... 8-53

8.2 Displaying a Waveform .................................................. 8-53
8.2.1 Complete Waveform ...................................................... 8-53
8.2.2 Single Segment ............................................................. 8-53
8.2.3 Single Component .......................................................... 8-53

8.3 Markers ............................................................................... 8-54
8.3.1 Editing Markers .............................................................. 8-54
8.3.1.1 Adding Markers ........................................................ 8-54
8.3.1.2 Configuring Markers ............................................... 8-55
8.3.1.3 Deleting Markers ..................................................... 8-55
8.3.2 Displaying Markers ....................................................... 8-55

8.4 X Scale ............................................................................... 8-55
8.5 Zero Line ........................................................................... 8-55

9 Starting Help (?) .............................................................. 9-56
9.1 Help ................................................................................ 9-56
9.2 Info ................................................................................. 9-56

10 Adapting the Waveform Graph .......................................... 10-57

10.1 Waveform Display ......................................................... 10-57
10.2 Adapting the Display ...................................................... 10-58
10.2.1 Plot Settings ............................................................... 10-58
10.2.2 Zoom Settings ............................................................ 10-59

11 Index .................................................................................. 11-60
1 Introduction

1.1 Range of Applications

Introduction
The "Waveform Composer" software for PCs is used for creating and managing arbitrary waveforms within a Windows NT, 2000 or XP operating system. These waveforms can be defined with the aid of appropriate mathematical functions or point-by-point. Two waveforms can be edited and displayed at the same time.

At the press of a button you can export the waveforms you have created, or use them to control the arbitrary and function generator R&S AM300.

Software integration
The PC software can be started independently, or via the remote-control software on the R&S AM300. The export function processes the waveforms according to the specification of the R&S AM300 and transmits the waveforms and/or their parameters to the generator via the USB.

1.2 Accessories Supplied

Contents
1 USB cable
1 manual in English and German
1 CD (contents: Manual in English and German, Waveform Composer software for PC, Acrobat Reader™)
2 Installation and Configuration

2.1 Installing the PC Software

Hinweis

To install the PC software, you must have administrator rights on your PC. (Windows™ help).

The <Back> button enables the user to go back one step during installation. Installation can be interrupted by pressing <Cancel>.

Installation steps

1. Place the CD ROM, which came with the product, in your installation drive. The autorun function automatically initiates installation. Alternatively you may also initiate the installation in the start menu of Windows™ Start|Run using the Setup.exe from the CD.

The installation is prepared and the installation wizard appears.
2. Click <Next> to continue the installation.

![Waveform Composer Setup]

2. Click <Next> to continue the installation.

3. Click <Browse> to assign a new directory if you wish to install the program in another directory than proposed. Click <Next> to continue the installation.

![Destination Folder]

3. Click <Browse> to assign a new directory if you wish to install the program in another directory than proposed. Click <Next> to continue the installation.
4. Click <Next> to continue the installation. Installation begins and the data are transferred to the PC. Please wait a moment.

5. Click <Finish> to successfully complete the installation.

6. Depending upon the system configuration, you may be prompted to restart your PC. Click <Yes> to restart the computer.

All new settings are now effective and the following appears in the Windows™ Start\Programs\Rohde & Schwarz\Series300 start-up menu:
2.2 Registering the PC Software

Introduction

The Waveform Composer software for PCs offers you the opportunity to transmit generated waveforms to a arbitrary and function generator R&S AM300. This can be done either with the aid of a USB stick or by using the R&S AM300-K1 software for PCs (R&S AM300 Operating Manual).

Before you can transmit waveforms from the Waveform Composer software to a specific arbitrary and function generator R&S AM300, you must enable the instrument concerned. When you purchased the Waveform Composer software you acquired a licence allowing you to enable a maximum of five R&S AM300 generators. If you wish to enable additional instruments you require a new licence (for a further five instruments). You only need to install the Waveform Composer software once.

There are five registration numbers on the back of your operating manual. To enable an instrument simply send in one of these numbers with the serial number of the instrument concerned. You will then receive an installation key. You can use the installation key and the R&S AM300-K1 software (remote control) to carry out the enabling procedure.

2.2.1 Requesting an Installation Key for the R&S AM300

How to make your request

To obtain an installation key (also called a key code), please send the following information to:

registration.smart-instruments@rsd.rohde-schwarz.com

- Your company address, e-mail address and telephone number
- The type and serial number of the instrument (e.g. R&S AM300, 123456)
- A software registration number (back of operating manual)

Note: If you would like more than one key code, please send the serial numbers of all the instruments concerned together with a registration number for each (up to a maximum of five).

How we reply

When we receive your information we shall immediately send you the key code for the enabling procedure.

Note: If it is not possible for you to receive key codes by e-mail, or if you have any specific inquiries, please contact your dealer or your nearest Rohde & Schwarz office. The addresses of Rohde & Schwarz offices can be found in the R&S AM300 Operating Manual.
2.2.2 Enabling an Instrument

Note

Before you can enable an arbitrary and function generator R&S AM300, you must have installed and authorized the associated PC-based software R&S AM300-K1 for instrument remote control (R&S AM300 operating manual).

In order to start the Series 300 Software Manager it is important to close any other Series 300 programs (such as FS300-K1, SM300-K1, AM300-K1).

Introduction

When you have installed the Waveform Composer software you will find the following entries under Start\Programme\Rohde & Schwarz\Series300 in the Windows™ Start menu:

You can use the service program Series 300 Software Manager to enable the Waveform Composer software for five arbitrary and function generators R&S AM300.

Starting the service program

1. Close all Series 300 programs (e.g. FS300-K1, SM300-K1, AM300-K1).

2. In the Windows™ start-up directory select: Start\Programs\Rohde & Schwarz\Series300\Series 300 Software Manager

The service program initializes. The program interface is divided into two areas:

I A list of all previously connected Smart instruments
II Information, status fields and command buttons for authorization
Entering the key code

3. In I click on the instrument for which you wish to enter the key code.

In II the authorization information is displayed:

(a) Current instrument information
(b) Instrument status
4. Click on **Authorization**. The entry field for the key code opens.

![Authorization dialog box]

5. Enter the key code and click **OK**. If the key code has been entered correctly, the instrument status in II changes from – to ✓.

![Instrument status]

Click on **Exit** in II in order to close the service program.

You can now start the **Waveform Composer** program and load waveforms into the instrument you have enabled.

---

**Note**

Once an instrument has been enabled it cannot be replaced by another, since a key code can only be issued once.
2.3 Starting the PC Software

2.3.1 Starting the Program

Starting the program

- In the Windows™ Start menu click on:
  Start\Programme\Rohde & Schwarz\Series300\Waveform Composer

The program starts and you can begin creating and editing waveforms.

Current defaults are loaded

When you start the program a new session opens automatically and the settings that were active at the time of the last exit from the program are loaded again.

When you start the program for the very first time a factory default is active.

**Note:** It is also possible to set the configuration so that the most recently used file is loaded (§ 5-28).

2.3.2 Closing the Program

Closing the program

- In Windows™ click on the close symbol x.

You may also select the option **Exit** in the pull-down menu **File**.
2.4 Uninstalling the PC Software

Installation steps for Windows™ 2000

1. Place the CD ROM, which came with the product, in the installation drive. The autorun function automatically initiates installation. Alternatively you may also initiate the installation in the start menu of Windows™ Start\Run using the Setup.exe from the CD. The uninstallation is prepared and the uninstallation assistant appears.

2. Click <Next> to continue the uninstallation.

3. Click <Finish> to complete the uninstallation.

Note

The PC software can also be uninstalled using the Windows™ control panel.
3 Getting Started

3.1 Editing a Waveform

Follow these steps:

1. Open the File menu – create a new waveform e.g. New

2. Open the View menu – select a view e.g. Complete Waveform

3. Open the File menu – open Configuration

4. Select a tab e.g. Channel 1

5. Set the sample rate e.g. 100000
6. Specify maximum number of samples e.g. 100000

7. Set the output voltage limits with Voltage - Maximum/Minimum e.g. +5 V / -5 V

3.2 Editing a Segment

Follow these steps

1. Select a segment e.g. Segment 1

2. Enter the waveform duration e.g. 100 ms

3. Adjust the number of samples for the segment e.g. 10000

4. Enter a name for the segment e.g. S1
3.3 Editing a Component

3.3.1 Set Vector Format Parameters

Follow these steps:

1. Open the View menu – select a view e.g. Single Component

2. Select the first component e.g. Select from list

3. Select a waveform e.g. Sinusoid

4. Select a function e.g. Add

5. Set parameters e.g. 1000 Hz, 4 V, 0°, 1 V

6. Enter the name of the component e.g. C1
7. Create second component  e.g. open Edit menu - New Component

8. Select second component  e.g. Select from list

9. Select a waveform  e.g. Triangular

10. Select a function  e.g. Multiply

11. Set parameters  e.g. 20 Hz, 2 V, 0°, 0 V, 50 %

12. Enter the name for the component  e.g. C2
3.3.2 Drawing in Draw Format

Follow these steps:

1. Select a component  e.g. Second Component

2. Convert the component to Draw format  e.g. open Edit menu Component To Point

3. Press the Paintbox button

4. Press the Pen button

5. Use the pen to change the waveform (hold down the left mouse button and draw over the waveform)

6. Press the Pen button again to close the Paintbox
4 Operating Concept

4.1 Structure of the Program Interface

Control elements

- **Pull down menu**
  - All control functions are structured in menu functions
- **Toolbar**
  - Tool kit for the major functions
- **Waveform parameters**
  - Important waveform parameters
- **Segment parameters**
  - All the parameters of the selected segments
- **Component parameters**
  - All the parameters of the selected component
- **Waveform information**
  - Important information about the view and the waveform
- **Waveform graph**
  - For representing the waveform in one or two displays.
4.2 Selecting Functions

Operating and display functions

- You can use the pull down menu to access all the operating and display functions. Selecting a function immediately triggers an action or opens a dialog box which can be used to define further parameters.

- Most functions also have a key combination known as a hot key to speed up processing, e.g. for saving:
  
  **Ctrl+S**

- For quick and easy operation the mouse can be used with the Toolbar.

Specific parameters

Specific parameters for segment functions and component functions are set directly into entry fields and selection fields, e.g. for selecting the waveform.

Drawing waveforms

Waveforms can be drawn one point or one stroke at a time by selecting the component function **Draw** and its associated tools.
### 4.3 Overview of Functions

#### 4.3.1 Pull Down Menus

#### 4.3.1.1 File

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+H</td>
<td></td>
<td>Begin new session</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
<td></td>
<td>Open stored session</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td></td>
<td>Save current session</td>
</tr>
<tr>
<td>Save As…</td>
<td></td>
<td></td>
<td>Save current session as</td>
</tr>
<tr>
<td>Page Setup…</td>
<td></td>
<td></td>
<td>Set up page for printing</td>
</tr>
<tr>
<td>Print Window…</td>
<td>Ctrl+P</td>
<td></td>
<td>Print active window</td>
</tr>
<tr>
<td>File Information…</td>
<td></td>
<td></td>
<td>Display information on waveforms</td>
</tr>
<tr>
<td>Configuration…</td>
<td>Ctrl+G</td>
<td></td>
<td>Set system configurations</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl+Q</td>
<td></td>
<td>Exit program</td>
</tr>
<tr>
<td>1: E:\Series300\Waveforms\10000+20000.amb</td>
<td></td>
<td></td>
<td>Display of files last used</td>
</tr>
</tbody>
</table>

#### 4.3.1.2 Edit

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td></td>
<td>Cut segment or component</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td></td>
<td>Copy segment or component</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td></td>
<td>Insert segment or component</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td>Delete segment or component</td>
</tr>
<tr>
<td>Clear Clipboard</td>
<td></td>
<td></td>
<td>Delete clipboard contents</td>
</tr>
<tr>
<td>New Segment</td>
<td>Ctrl+A</td>
<td></td>
<td>Insert new segment</td>
</tr>
<tr>
<td>New Component</td>
<td>Ctrl+B</td>
<td></td>
<td>Insert new component</td>
</tr>
<tr>
<td>Waveform To Point</td>
<td></td>
<td></td>
<td>Convert waveform from vector format to points</td>
</tr>
<tr>
<td>Segment To Point</td>
<td></td>
<td></td>
<td>Convert segment from vector format to points</td>
</tr>
<tr>
<td>Component To Point</td>
<td></td>
<td></td>
<td>Convert component from vector format to points</td>
</tr>
<tr>
<td>Import…</td>
<td></td>
<td></td>
<td>Import waveform</td>
</tr>
<tr>
<td>Export…</td>
<td></td>
<td></td>
<td>Export waveform</td>
</tr>
</tbody>
</table>

1: E:\Series300\Waveforms\10000+20000.amb
2: E:\Series300\Waveforms\12x20000.amb
3: E:\Rus\AM\Waveform Compose\12x\128.amb
4: E:\Rus\AM\Waveform Compose\12x\128.amb
### 4.3.1.3 View

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display 1</td>
<td>Ctrl+1</td>
<td>![1]</td>
<td>Show display 1</td>
</tr>
<tr>
<td>Display 2</td>
<td>Ctrl+2</td>
<td>![2]</td>
<td>Show display 2</td>
</tr>
<tr>
<td>Display 1 &amp; 2</td>
<td>Ctrl+3</td>
<td></td>
<td>Show displays 1 and 2 at the same time</td>
</tr>
<tr>
<td>Complete Waveform</td>
<td>Ctrl+4</td>
<td></td>
<td>Display complete waveform and all segments</td>
</tr>
<tr>
<td>Single Segment</td>
<td>Ctrl+5</td>
<td></td>
<td>Display selected segment</td>
</tr>
<tr>
<td>Single Component</td>
<td>Ctrl+6</td>
<td></td>
<td>Display selected component</td>
</tr>
<tr>
<td>Marker...</td>
<td>Ctrl+M</td>
<td></td>
<td>Open the Marker menu</td>
</tr>
<tr>
<td>X-Scale: Samples</td>
<td></td>
<td></td>
<td>Display the points on the X scale</td>
</tr>
<tr>
<td>X-Scale: Time</td>
<td></td>
<td></td>
<td>Display the time domain on the X scale</td>
</tr>
</tbody>
</table>

### 4.3.1.4 ? Help

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td></td>
<td>Call help on the program (§ 9-56)</td>
</tr>
<tr>
<td>Info Ctrl+I</td>
<td></td>
<td>Display program information (§ 9-56)</td>
</tr>
</tbody>
</table>

### 4.3.2 Toolbar

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin new session         (§ 6-40)</td>
</tr>
<tr>
<td>Open stored session      (§ 6-40)</td>
</tr>
<tr>
<td>Save current session     (§ 6-40)</td>
</tr>
<tr>
<td>Print active window      (§ 6-41)</td>
</tr>
<tr>
<td>Cut segment or component (§ 7-42)</td>
</tr>
<tr>
<td>Copy segment or component (§ 7-42)</td>
</tr>
<tr>
<td>Insert segment or component (§ 7-43)</td>
</tr>
<tr>
<td>Insert new segment       (§ 5-30)</td>
</tr>
<tr>
<td>Insert new component     (§ 5-33)</td>
</tr>
<tr>
<td>Show display 1           (§ 8-53)</td>
</tr>
<tr>
<td>Show display 2           (§ 8-53)</td>
</tr>
<tr>
<td>Play back waveform as sound</td>
</tr>
</tbody>
</table>
5 Creating a Waveform

5.1 Waveform Parameters

5.1.1 Structure of a Waveform

Main structure
A waveform is a signal sequence consisting of one or more segments. The segments are set to follow one another consecutively.

A waveform can consist of up to 262144 points (samples) and is displayed as a curve of points. Once defined, a waveform can be managed with the aid of various functions (Open, Save, Import, Export etc.) and be functionally extended (New Segment etc.).

Parameter dependencies
The maximum samples in a waveform must be specified in advance within the configuration. Configuration defaults set limits on the parameters in the Duration and/or Samples ranges. These two parameters interact with one another. This also affects Start Phase or Start Samples. These parameters do not cause any change in the display, but are calculated as appropriate during an Export. Other configuration settings for a waveform are Sample Rate, Sample, Resolution, Autoscale and Maximum/Minimum.
5.1.2 Configuring a Waveform

Ways to select the setting window

- Configuration submenu in the File pull down menu
- Hot key combination Ctrl+G

5.1.2.1 Channel 1

Setting parameters for channel 1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>Specifies the sample rate for the R&amp;S AM300</td>
</tr>
<tr>
<td>Maximum Samples</td>
<td>Maximum number of samples for channel 1 (2)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution of the DAC</td>
</tr>
</tbody>
</table>
| Voltage         | **Autoscale (on)**
|                 | output values are normalized so that the peak amplitude value fully modulates the DAC |
|                 | **Autoscale (off)**
|                 | the amplitude that is output is the same as the values displayed in the graphical window |
| Maximum         | Display range maximum                                                        |
| Minimum         | Display range minimum                                                        |

**Note**

Autoscale has no effect on the display. This function uses the whole range of the DAC and improves the dynamic range of the D/A converter.
5.1.2.2 Channel 2

Setting parameters for channel 2

Note

Parameters are set as in channel 1.
The parameters (other than Sample Rate) can be set separately for both channels. Although the Sample Rate can in fact be set individually, it always applies to both channels.

5.1.2.3 Colours

Note

The colour setting always applies to both displays and to the current program interface.

Colour setting

Plot Waveform colour
Plot Highlighted Colour of the waveform to be edited in "Single Component" view
Plot Background Background colour of display
Plot Selection Colour of the segment selection in "Complete Waveform" view
Grid Grid colour
Marker Marker colour
Panel Background Background colour of panel
5.1.2.4 Miscellaneous

Setting and managing specific configurations

History
The number of files you wish to store in the History list

Continue with last file
The most recent file in the History list will be loaded on starting the program

Load...
Open and update configuration files

Save...
Save configuration files
5.1.3 Displaying the Parameters

Waveform parameters

The parameters for the active waveform are displayed after selection. Sample Rate has the same value for both waveforms.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>Sample rate for the R&amp;S AM300</td>
</tr>
<tr>
<td>Start Phase</td>
<td>Start phase for the waveform</td>
</tr>
<tr>
<td>Start Sample</td>
<td>Start samples for the waveform</td>
</tr>
</tbody>
</table>

Waveform graph

Selecting and displaying the waveform:
- Two waveforms in two different displays
  - View 1
    - Display 1: Ctrl+1
    - Display 2: Ctrl+2
    - Display 1 & 2: Ctrl+3
- One waveform in a single display
  - View 2
    - Display 1: Ctrl+1
    - Display 2: Ctrl+2
    - Display 1 & 2: Ctrl+3

Waveform information

- Sample display: Displays the maximum samples per channel (red means the maximum has been reached or exceeded)
- Display selection: The whole waveform is displayed via "Complete Waveform"
- Segment information: Displays the waveform parameters (Begin, End, Length in time and samples) for the selected segment
5.2 Segment Parameters

5.2.1 Structure of a Segment

Main structure
Segments are waveforms composed of mathematical (vectorized) or point components. Components are interconnected via arithmetical functions. The result of all the components is a segment.

Parameter dependencies
Segments are defined by the number of samples or the duration of the waveform. The ratio of the samples to the sample rate defines the duration of the segment.

\[
\text{Duration [s]} = \frac{\text{Sample [n]}}{\text{Sample Rate [Hz]}}
\]

\[
0.002 \text{ [s]} = \frac{10000}{5000000} \text{ [1/s]}
\]

5.2.2 New Segment

Ways to insert a new segment
- New Segment submenu in the File pull down menu
- Hot key combination Ctrl+G
- Toolbar [ ]
5.2.3 Displaying the Parameters

Segment parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Duration</th>
<th>Samples</th>
<th>2^n</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>1,024 s</td>
<td>1,024</td>
<td>1</td>
</tr>
<tr>
<td>S2</td>
<td>1,024</td>
<td>1,024</td>
<td>1</td>
</tr>
</tbody>
</table>

Segment display list:
- S1 (1024 Samples)  First segment showing its name and number of samples
- S2 (1024 Samples)  Second segment showing its name and number of samples

Waveform information

- Display selection: A selected segment is displayed via "Single Segment".
- Segment information: Displays the waveform parameters (Begin, End, Length in time and samples) for the selected segment.

<table>
<thead>
<tr>
<th>Time</th>
<th>Begin</th>
<th>End</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>0</td>
<td>1024</td>
<td>1024</td>
</tr>
</tbody>
</table>

Note: The number of samples for the complete waveform should always be a multiple of $2^n$. This is the only way the waveform memory in the R&S AM300 can be kept full. Otherwise the unused memory area will be padded with zeros.
5.2.4 Adapting the Samples

For standard components
When the samples for standard components are changed the waveform is recalculated and displayed in its new form.

For Draw components
When the samples for Draw components are changed a window is opened offering different methods of adaptation.

C1 [Draw] Name of segment
Stretch/toss to fit Waveform is stretched and/or tossed
Resize (cut/fill) Waveform is cut and/or filled
Periodic resize Waveform is periodically filled
5.3 Component Parameters

5.3.1 Structure of a Component

Main structure: A component is a mathematical function or a point waveform which is defined with the aid of parameters.

5.3.2 New Component

Ways to insert a new component:
- **New Component** submenu in the File pull down menu
- Hot key combination **Ctrl+B**
- Toolbar

![Component Diagram]
5.3.3 Displaying the Parameters

### Component display list:

- **C1 [Add] Sinusoid**
- **C2 [Multiply] Formula**
- **C3 [Subtract] Draw**

**Name**: Name of component

**Waveform**: Waveform selection for component

**Function**: Mathematical operation for linking to components

#### Parameters of the active waveform:

- **Frequency**: Frequency
- **Vpp**: Peak-to-peak voltage
- **Phase**: Phase
- **Offset**: Offset

**Waveform information**: A selected component is displayed via "Single Component". The selected component is highlighted in a different colour and can be edited.

**Note**: In the case of Sinusoid, Rectangular, Triangular and Exponential waveforms you can enter not only the frequency in [Hz] but also the periods [cyc].
5.3.4  Editing a Component

Selecting a component  
Click in the Waveform selection field

<table>
<thead>
<tr>
<th>Name</th>
<th>Waveform</th>
<th>Function</th>
<th>Frequency</th>
<th>Vpp</th>
<th>Phase</th>
<th>Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sinusoid</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triangular</td>
<td>Rectangular</td>
<td>Sweep</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>White Noise</td>
<td>Exponential</td>
<td>Formula</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting the parameters  
Click in the entry fields of the active waveform

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2 Hz</td>
</tr>
<tr>
<td>Vpp</td>
<td>2 V</td>
</tr>
<tr>
<td>Phase</td>
<td>0 °</td>
</tr>
<tr>
<td>Offset</td>
<td>0 V</td>
</tr>
</tbody>
</table>

5.3.4.1  Standard Waveforms

<table>
<thead>
<tr>
<th>Waveform</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Level</td>
<td>Offset [V]</td>
</tr>
<tr>
<td>Sinusoid</td>
<td>Frequency [Hz], Vpp [V], Phase [°], Offset [V]</td>
</tr>
<tr>
<td>Triangular</td>
<td>Frequency [Hz], Vpp [V], Phase [°], Offset [V], Symmetry [%]</td>
</tr>
<tr>
<td>Rectangular</td>
<td>Frequency [Hz], Vpp [V], Phase [°], Offset [V], Duty Cycle [%]</td>
</tr>
<tr>
<td>Sweep</td>
<td>Start [Hz], Stop [Hz], Vpp [V], Offset [V]</td>
</tr>
<tr>
<td>White Noise</td>
<td>Start [Hz], Stop [Hz], Vpp [V], Offset [V]</td>
</tr>
<tr>
<td>Exponential</td>
<td>Frequency [Hz], V0 [V], Vinf [V], Tau [s]</td>
</tr>
</tbody>
</table>
## 5.3.4.2 Formula Waveform

### Introduction

Formula node syntax is similar to a text-based programming language and can be used within the Formula function. Press the Change button in order to enter formulas. Functions can be nested and may consist of multiple terms. The result is displayed as a graph.

![Input Formula String](image)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs(x)</td>
<td>Absolute value</td>
<td></td>
</tr>
<tr>
<td>acos(x)</td>
<td>Inverse cosine</td>
<td></td>
</tr>
<tr>
<td>acosh(x)</td>
<td>Inverse hyperbolic cosine</td>
<td></td>
</tr>
<tr>
<td>asin(x)</td>
<td>Inverse sine</td>
<td></td>
</tr>
<tr>
<td>asinh(x)</td>
<td>Inverse hyperbolic sine</td>
<td></td>
</tr>
<tr>
<td>atan(x)</td>
<td>Inverse tangent</td>
<td></td>
</tr>
<tr>
<td>atanh(x)</td>
<td>Inverse hyperbolic tangent</td>
<td></td>
</tr>
<tr>
<td>ceil(x)</td>
<td>Round to + infinity</td>
<td></td>
</tr>
<tr>
<td>ci(x)</td>
<td>Cosine integral</td>
<td></td>
</tr>
<tr>
<td>cos(x)</td>
<td>Cosine</td>
<td></td>
</tr>
<tr>
<td>cosh(x)</td>
<td>Hyperbolic cosine</td>
<td></td>
</tr>
<tr>
<td>cot(x)</td>
<td>Cotangent</td>
<td></td>
</tr>
<tr>
<td>csc (x)</td>
<td>Cosecant</td>
<td></td>
</tr>
<tr>
<td>exp(x)</td>
<td>Exponential</td>
<td></td>
</tr>
<tr>
<td>expm1(x)</td>
<td>Exponential (arg) – 1</td>
<td></td>
</tr>
<tr>
<td>floor(x)</td>
<td>Round to – infinity</td>
<td></td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>gamma(x)</td>
<td>Gamma function</td>
</tr>
<tr>
<td>getexp(x)</td>
<td>Mantissa &amp; exponent</td>
</tr>
<tr>
<td>getman(x)</td>
<td>Mantissa &amp; exponent</td>
</tr>
<tr>
<td>int(x)</td>
<td>Round to nearest</td>
</tr>
<tr>
<td>intrz(x)</td>
<td></td>
</tr>
<tr>
<td>ln(x)</td>
<td>Natural logarithm</td>
</tr>
<tr>
<td>lnp1(x)</td>
<td>Natural logarithm (arg + 1)</td>
</tr>
<tr>
<td>log(x)</td>
<td>Logarithm base 10</td>
</tr>
<tr>
<td>log2(x)</td>
<td>Logarithm base 2</td>
</tr>
<tr>
<td>max(x,y)</td>
<td>Max &amp; min</td>
</tr>
<tr>
<td>min(x,y)</td>
<td>Max &amp; min</td>
</tr>
<tr>
<td>mod(x,y)</td>
<td>Quotient &amp; remainder</td>
</tr>
<tr>
<td>pi(x)</td>
<td>Represents the value = 3.14159...</td>
</tr>
<tr>
<td>rand( )</td>
<td>Random number (0 – 1)</td>
</tr>
<tr>
<td>rem(x,y)</td>
<td>Quotient &amp; remainder</td>
</tr>
<tr>
<td>sec(x)</td>
<td>Secant</td>
</tr>
<tr>
<td>si(x)</td>
<td>Sine integral</td>
</tr>
<tr>
<td>sign(x)</td>
<td>Sign</td>
</tr>
<tr>
<td>sin(x)</td>
<td>Sine</td>
</tr>
<tr>
<td>sinc(x)</td>
<td>Sinc</td>
</tr>
<tr>
<td>sinh(x)</td>
<td>Hyperbolic sine</td>
</tr>
<tr>
<td>spike(x)</td>
<td>Spike function</td>
</tr>
<tr>
<td>sqrt(x)</td>
<td>Square root</td>
</tr>
<tr>
<td>square(x)</td>
<td>Square function</td>
</tr>
<tr>
<td>step(x)</td>
<td>Step function</td>
</tr>
<tr>
<td>tan(x)</td>
<td>Tangent</td>
</tr>
<tr>
<td>tanh(x)</td>
<td>Hyperbolic tangent</td>
</tr>
</tbody>
</table>
5.3.4.3 Draw Waveform

The Draw function is selected in Waveform and offers various methods for drawing one point or one stroke at a time.

When you select the Draw waveform (5-35) the toolbox is displayed. If you then click the button you can use the various Draw functions. Always select the current segment in "Single Component" view. You can then zoom (10-59) the point waveform and draw it as required.

**Draw – Pencil**

When you click on the pencil, the range limits are adopted and zooming is no longer possible. When you move the mouse over the display the coordinates are adopted and displayed. You may then press your left mouse button and drag the pointer over the display to begin changing the waveform **one point at a time**. You stop making changes to the waveform when you release the mouse button again. You can activate the creation of **strokes** (or lines) with the aid of the Shift key. Simultaneously hold down the Shift key and the mouse button to define the first point. Then drag the pointer across the display to create a straight line which ends at the point where you release the Shift key.

**Draw – View**

This button displays the results of the Draw function. Pressing the button displays the point waveform and the results of the whole segment. If the number of samples is large, this display can slow down the processing and display of waveforms. To obtain faster processing you can first disable the button or secondly reduce the range of the waveform (zoom, 10-59).

**Draw – Undo**

Points drawn in the waveform are discarded when you use this button. Any changes you made to the range are actually adopted when you deactivate the pencil button. The selected waveform ranges are then inserted into the segment and it is no longer possible to undo any previous actions. However, the Undo function can cancel the changes if the pencil button is still active.

**Note**

You can accurately determine and display a position by zooming (10-59) a segment range. You can thus adapt the waveform with pinpoint accuracy.

The Zoom tool cannot be used once the Draw pencil has been activated, and is therefore hidden. Thus you should define the zoom range before you draw. The coordinates (X direction: Sample; Y direction: Voltage) are displayed below the toolbox for guidance.
6 Editing Data (File)

6.1 Internal File Format

A special format has been chosen for backing up both waveforms. They are stored as a binary file (*.amb).

The memory format contains a file header (file version, creation dates, user name and comment) followed consecutively by the two waveforms, each with a data header (Sample Rate, Resolution, Amplitude, Start Samples and Max. Samples), as well as marker positions and waveform data.

The waveform data is vectorized in order to minimize the size of the saved file and to enable individual components to be further edited.
6.2 Managing Data

6.2.1 New

Function
An empty waveform is loaded so that details can be added. If you have changed the current waveform, you are asked whether you wish to save it.

6.2.2 Open...

Function
Opens a stored or exported file in the internal format (binary *.amb) in both channels. A file dialog box opens.

If you confirm the new file and have changed the current waveform, you are asked whether you want to save it before loading the new file.

6.2.3 Save

Function
The waveform currently displayed in both channels is saved in the internal binary format under the file name shown in the menu bar. When the program has just been started or New has been used, the Save function works like Save As..., and a new file name is requested.

6.2.4 Save As...

Function
The waveform currently displayed in both channels is saved in the internal binary format under a new file name.

6.2.5 File Information

Function
Displays information about a file. You may enter notes about the waveform in the Comment box.
6.3 Printing Data

6.3.1 Page Setup...

Function

This function is used for specifying the print settings and the printer setup.

Print header
A header showing the file name, program name, amendment date, printing date and page number is added when a window is printed out.

Use default margins from preferences
The printer adopts the default margin settings.

Custom margins
User-defined margin settings are adopted.

6.3.2 Print Window...

Function
The current window is printed out on the standard printer without further questions.
7 Editing a Waveform (Edit)

7.1 General Functions

You can use the functions Cut, Copy, Paste and Delete on a segment or component according to choice. When you select one of these submenus a dialog window is displayed for you to make a choice. If you click OK your choice is confirmed and the requested action is carried out. Cancel closes the window and the action is not carried out.

7.1.1 Cut Function
The selected segment or component is cut, i.e. removed from the active waveform and placed on the Clipboard.

7.1.2 Copy Function
The selected segment or component is copied to the Clipboard, but not removed from the waveform.
7.1.3 Paste

Function
The contents of the Clipboard are inserted in the active waveform as a segment or component, in each case directly after the selected segment or component. The Clipboard itself remains unchanged by this action.

Paste segment as new component
If a segment is pasted as a new component ("Cut/Copy segment", "Paste as new component"), all components of the original segment are pasted into the currently selected segment after the selected component.

Paste component as new segment
If a component is pasted as a new segment ("Cut/Copy component", "Paste as new segment"), a new segment consisting of the component held on the Clipboard is pasted after the currently selected segment.

Cannot be executed
When you first start the Waveform Composer or use "Clear Clipboard" the Clipboard is empty. In this situation the Paste function cannot be executed.

7.1.4 Delete

Function
The selected segment or component is removed from the active waveform. The Clipboard remains unchanged.

7.1.5 Clear Clipboard

Function
The contents of the Clipboard are deleted. If there is no longer enough free RAM for other applications, this can be a useful way of reducing the amount of memory required by the Waveform Composer.

7.2 Specific Functions

7.2.1 New Segment

Function
A new segment is pasted after the selected segment of the active waveform. Parameters can then be assigned to the segment.

7.2.2 New Component

Function
A new component is pasted after the selected component of the active waveform. The component can then be assigned parameters or can be drawn.
7.2.3 Converting Formats

From vector format to Draw format

The following functions convert a waveform or part of a waveform from vector format (mathematical calculation of the waveform sequence from parameters) to Draw format (point-by-point definition of the waveform sequence). By this method the calculation results are saved as a sequence of points in which the interval between points is defined by the sample rate. Draw format is also known as pixel format or point format, which is why these functions are named "... to Point".

7.2.3.1 Waveform to Point

Function

The complete active waveform is converted to Draw format. The waveform then consists of just a single segment with one Draw component.

7.2.3.2 Segment to Point

Function

The selected segment of the active waveform is converted to Draw format. The segment then consists of just a single Draw component. All other segments remain unaffected.

7.2.3.3 Component to Point

Function

The selected component of the active waveform is converted to Draw format. All other components remain unaffected.
7.3 External File Formats

7.3.1 Description

MATLAB SINGLE / IQSIM (*.i, *.q) These files have following format:
1.000000
2.000000
3.000000
....

MATLAB MIXED (*.mat) Binary file format. The file should contain 2 differently named arrays (i.e. “I” and “Q”). Following C - example code shows how to generate the *.mat file correctly.

MATFile *fp;
double Iarr[1024], Qarr[1024];
mxArray *p;
// fill IArr and Qarr with iq data
........
fp = matOpen (d.INam, "w");
p = mxCreateDoubleMatrix (1, 1024, mxREAL);
mempcpy (mxGetPr (p), IArr, 1024 * sizeof (double));
mxSetName (p, "I");
matPutArray (fp, p);
mempcpy (mxGetPr (p), QArr, 1024 * sizeof (double));
mxSetName (p, "Q");
matPutArray (fp, p);
mxFree (p);
free (IArr);
free (Qarr);
matClose (fp);

MATHCAD / COSSAP SINGLE (*.i, *.q) Have a dynamic format; integer, float and exponential format; up to 199 characters per line; comment starts with %.
1.0 2 3.0 4e0 5e0 6.00000 % Yeah Yeah 1.3
7.0 8 9.0 1e1 1.10e1 12.00000 % No No 1.7

MATHCAD / COSSAP MIXED (*.dat) Same as single, only that consecutive values are an I and Q pair so the value count must always be even.
External File Formats  

PC Software R&S Waveform Composer

DADISP SINGLE
(*.i, *.q)

DATASET i
VERSION NEXT
NUM SIGS 1
STORAGE MODE INTERLACED
SIGNAL i
DATE 11-29-2000
TIME 14:49:26
INTERVAL 1.000000E+02
VERT_UNITS volt
HORZ_UNITS sec
COMMENT
DATA
1.000000
2.000000
3.000000
4.000000
.....

DADISP MIXED
(*.dsp)

DATASET i, q
VERSION NEXT
NUM SIGS 2
STORAGE MODE INTERLACED
SIGNAL i, q
DATE 12-27-2000
TIME 14:23:59
INTERVAL 1.000000E-06
VERT_UNITS volt
HORZ_UNITS sec
COMMENT
DATA
0.000000e+00 0.000000e+00
6.278100e-02 0.000000e+00
1.253130e-01 0.000000e+00
1.873750e-01 0.000000e+00
.....

SPW ASCII SINGLE
(*.ascsig, *.ascsig)

Uses the extension *.ascsig for I and Q data files. It is convenient to place this information in the file name, i.e. circle_i.ascsig.

$SIGNAL_FILE 9
$USER_COMMENT
$COMMON_INFO
SPW Version = 4.70
System Type = solaris2
Sampling Frequency = 65536000.0
Starting Time = 0.0
$DATA_INFO
Number of points = 20480
Signal Type = Double
$DATA
0.00427246
0.00476074
0.00299072
.....
<table>
<thead>
<tr>
<th>External File Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PC Software R&amp;S Waveform Composer</strong></td>
</tr>
</tbody>
</table>

**SPW ASCII MIXED**

```
$SIGNAL_FILE 9
$USER_COMMENT
$COMMON_INFO
SPW Version = 4.70
System Type = solaris2
Sampling Frequency = 65536000.0
Starting Time = 0
$DATA_INFO
Number of points = 20480
Signal Type = Double
Complex Format = Real_Imag
$DATA
0.00427246+j0.06279034
0.00476074-j0.24868988
0.00299072+j0.53582679
```

**SPW BINARY MIXED**

```
$SIGNAL_FILE 9
$USER_COMMENT
$COMMON_INFO
SPW Version = 4.70
System Type = solaris2
Sampling Frequency = 65536000.0
Starting Time = 0
$DATA_INFO
Number of points = 20480
Signal Type = Double
Complex Format = Real_Imag
$DATA
<I0 64-bit REAL><Q0 64-bit REAL><I1 64-bit REAL> <Q1 64-bit REAL><I2 64-bit REAL><Q2 64-bit REAL><I3 64-bit REAL> <Q3 64-bit REAL>........
```

**ADS ASCII SINGLE**

```
See ADS single.
```

**ADS ASCII MIXED**

```
See SPW mixed.
```

**WAV Files**

```
Binary audio file format. Can be used to store I/Q data. I/Q wizard only accepts 8 and 16-bit stereo format.
```

**LECROY**

```
Binary 8 or 16-bit format containing 2 channels generated with LeCroy’s general oscilloscope controlling software **SCOPE EXPLORER** available at [http://www.lecroy.com](http://www.lecroy.com).
```

**DAB-K1**

```
Binary file format. DAB-K1 is a software for generation of various DAB and DVB signals for spectrum evaluation. DAB-K1 is available at [http://www.rohde-schwarz.com](http://www.rohde-schwarz.com).
```
**External File Formats**

**PC Software R&S Waveform Composer**

**_UINT16_**

(*.i, *.q)

16-Bit format ranging from 1 to 65535 (0 is internally converted to 1). This format especially supports the AMIQ’s digital I/Q output (option AMIQ-B3). Transmitting this format to an AMIQ requires following WinIQSIM configuration (DEMO16BIT.IQS).

<table>
<thead>
<tr>
<th>IMPORT FILTER FUNCTION</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMIQ -&gt; SIGNAL STAT.AND QUANT</td>
<td>Use Peak Value: OFF</td>
</tr>
<tr>
<td></td>
<td>Level: 32767.0000</td>
</tr>
<tr>
<td></td>
<td>Resolution: 16-bit</td>
</tr>
<tr>
<td>AMIQ TRANSMISSION</td>
<td>Comp.Output Signal for sin(x)/x</td>
</tr>
<tr>
<td></td>
<td>Dist.: OFF</td>
</tr>
</tbody>
</table>

**AWG 2000**

(*.wmf, *.wmf)

Format for Tektronix AWG2000 series arbitrary waveform generators containing frequency and amplitude information in the header. The 12-bit I- and Q-values (0 ... 4095) are normalized to ± amplitude. Wmf demo files are available at [http://www.tektronix.com](http://www.tektronix.com).

**IQW**

(*.iqw, *.iqw)

4-byte binary float format.

NUMBER OF ELEMENTS = FILESIZE * 4
7.3.2 Import

Function

Imported waveforms are inserted in the internal or external format. The waveforms are uploaded in the form of a curve of points. They can be changed on a pixel-by-pixel basis only.

Import file type

At the start of the function you are asked to select the import file type. You can then select the file.

Data formats

- AM300 binary file format
- AM300 ASCII file format
- WinIQSIM import file *.ibn
- MatLAB single ASCII files
- MatLAB mixed ASCII file
- MatLAB single binary files
- MatLAB binary
- MathCAD single files
- MathCAD mixed file
- DaDisp single files
- DaDisp mixed
- Cosap single files
- Cosap mixed file
- SPW single ASCII files
- SPW mixed ASCII file
External File Formats

PC Software R&S Waveform Composer

- SPW mixed binary file
- ADS single ASCII files (cf. SPW)
- ADS mixed ASCII file (cf. SPW)
- WAVE format, 8-bit or 16-bit stereo
- LeCroy Scopes binary 8-bit or 16-bit format
- ASCII file format generated by IQSIM
- Binary file format for I and Q
- 16-bit binary format for direct AMIQ drive
- AWG2000 Arbitrary Waveform Editor format
- IQW mixed file
- AM300 instrument-specific format for enabled instrument

Specifying the path for the import file

In the case of mixed file formats the I and Q vectors are held in one file only. Specify the path for this file.

In the case of single file formats the I and Q vectors are held in two separate files. Specify the paths for the I vectors and Q vectors separately.
Pasting a waveform

When the file has been loaded, a selection window for pasting the waveform is displayed. The data to be pasted is shown as a separate graphic for each channel.

The following options are available for pasting waveforms:

- **Do not import this channel**

- **Import channel 1 (or 2) as a complete waveform**

  The current waveform will be overwritten

- **Import channel 1 (or 2) as a segment**

  In this case it is important to decide on the current segment after which the new segment has to be loaded.

- **Import channel 1 (or 2) as a component**

  In this case it is important to decide on the current segment in which the new component has to be loaded.
7.3.3 Export

Export file type

Exported waveforms are saved in the internal or external format. The waveforms are output in the form of a curve of points. When they are read in they can be changed on a pixel-by-pixel basis only.

At the start of the function you are asked to select the export file type. You can then select the file. If you chose a "mixed" format, only one file selection box is displayed. In the case of single files, two dialog boxes appear one after the other. If the second file has the same name as the first, a warning message is displayed.

Data formats

⇒ Import data formats, 7-49
8 Adapting the Active Window (View)

8.1 Displays

Introduction The following functions define which waveform is visible. If only one waveform is visible, it automatically becomes the active waveform, i.e. this waveform is changed by subsequent edit functions (e.g. New Segment).

8.1.1 Display 1

Function Waveform 1 is visible and active, waveform 2 is hidden.

8.1.2 Display 2

Function Waveform 2 is visible and active, waveform 1 is hidden.

8.1.3 Display 1&2

Function Both waveforms are shown. The waveform that was active is still active. If you want the other waveform to be active, you can use button 1 or 2 in the toolbar.

8.2 Displaying a Waveform

Introduction The following functions define which part of a waveform is visible. If both waveforms are visible, the functions affect both waveforms in the same way.

8.2.1 Complete Waveform

Function The complete waveform is displayed. The selected segment of the active waveform is highlighted with the "Plot Selection" colour.

8.2.2 Single Segment

Function The selected segment is displayed.

8.2.3 Single Component

Function The selected segment is displayed in the normal plot colour and the selected component is displayed using the "Plot Highlighted" colour.
8.3 Markers

Function
A separate marker trace can be defined for each waveform and is used to synchronize other signal sources.

8.3.1 Editing Markers

Calling the marker list
To configure the markers, select submenu View → Edit Marker. The display now changes to the "Display 1&2" mode. The markers of the waveform concerned are displayed in the work area together with their state (high, low). In the case of a newly created waveform the list is empty.

To exit the marker list, click the OK button at lower right.

8.3.1.1 Adding Markers

Adding markers to the list
To add a marker, click on the button. If the marker list is empty, the marker is inserted at the beginning of the waveform. If the list already contains markers, the new marker is inserted at the next available position in relation to the currently selected marker. The state of a newly inserted marker is always LOW.

Inserting markers in the graph
It is also possible to place new markers directly in the graph. Move the mouse pointer to one of the two border markings on the scale. The pointer changes to a positioning arrow. You can then hold down the mouse button and drag a new marker to the desired position.
8.3.1.2 Configuring Markers

- **Editing markers in the list**: If you want to change the position or state of a marker, select the marker concerned from the list. The position and present state of the marker are now shown in the entry field below the list. If you enter a new value in the Sample Index box or change the State box, the marker list is updated.

- **Repositioning a marker in the graph**: You can also position a marker in the graph itself. Click on the marker in the scale area, hold down the mouse button and drag the marker to the desired position.

  - To position the marker with greater accuracy you can zoom (10-59) any area of the graph. The X scroll bar appears so that you can still access all the samples in the graph.

  - You can finely adjust the marker setting in the Sample Index entry field.

**Note**: If you place a marker on an existing marker, the latter is overwritten by the current marker.

8.3.1.3 Deleting Markers

- **Deleting markers**: To remove a marker from the list, highlight the relevant list entry. Then click on . This updates the marker list.

8.3.2 Displaying Markers

- **Displaying markers in the graph**: When the marker list (8-54) is open, markers are shown in the appropriate display together with their state.

  - In order to view markers when the marker list is closed, select submenu View → Show Marker.

8.4 X Scale

- **X scale: Samples**: For displaying the X scale in samples
- **X scale: Time**: For displaying the X scale in time domain

8.5 Zero Line

- **Zero Line**: For displaying a zero line
9 Starting Help (?)

9.1 Help

Starting help

Acrobat Reader™ (CD-ROM) starts and the R&S AM300-K2 operating manual opens.

9.2 Info

Displaying the program version

An information field is displayed.

The information field automatically closes after about 10 seconds.
10 Adapting the Waveform Graph

10.1 Waveform Display

Structure of the waveform display
The display shows the complete waveform or individual segments as a plot. Within this display all points on the waveform or segment are depicted without compressing or adapting the pixels to the size of the screen. Areas of the screen can be zoomed and displayed with pinpoint accuracy.

1 Plot
The waveform as depicted in the display

2 Plot Highlighted
A specific display form which is possible in "Single Component" view only and highlights the waveform to be edited

3 Plot Selection
Highlights the selected segment

4 Grid
Grid over the display, used for guidance or to divide up the waveform

5 Marker
Markers are displayed after switching to the appropriate display.

6 X Scale
Scale showing the starting and final values of the samples or time domain

7 Plot Background
Background colour for the display

8 Y Scale
Scale for displaying voltage values

9 Plot Settings
Plot settings (10-58)

10 Zoom Settings
Zoom settings (10-59)
10.2 Adapting the Display

10.2.1 Plot Settings

Application

The graph uses a standard setting for each plot. This plot setting can be changed and adapted via a setting menu.

Note: The plot setting is volatile and therefore retained for one session only.

Plot settings

The Common Plots submenu helps you configure one of six commonly used plot settings. These include a scatter diagram, a bar graph and a diagram of the "fill to zero" type. The point, line and fill settings in the palettes for these submenus are preconfigured.

The Colour submenu displays the palette for selecting the plot colour.

The Line Style, Line Width and Point Style submenus display settings that can be used to differentiate a plot. The palette in the Line Width submenu contains widths starting from the default setting of 1 pixel upward, including hairline width. The latter option has no effect on the screen display, but prints out as a very thin line provided the printer and printing mode support hairline printing.

The edges of the waveform can be smoothed using the Anti-Aliased submenu.

The Bar Plots submenu provides a selection of vertical bars, horizontal bars and display without bars.

The Fill Base Line submenu defines how far from the base line the display will be filled. Zero fills from the plot as far as a base line generated at 0. +Infinity fills from the plot to the positive edge of the graph. -Infinity fills from the plot to the negative edge of the graph. You can use the lower section of this menu to select a specific plot within the graph, marking how far you wish the display to be filled.

The Interpolation submenu calls a palette from which you can select various point links or choose how the graph will draw lines between plotted points. In the first option no lines are drawn, making this ideal for a scatter diagram. The option at lower left draws a straight line between plotted points. The two stepped options, in which points are linked by lines bent at a right-angle, are useful for creating plots of the histogram type. The option at upper right plots in the Y direction first, and the option at lower right plots in the X direction first.

The X/Y Scale submenu displays the names of the X/Y scales in the graph.
## 10.2.2 Zoom Settings

The waveform graph provides a palette for setting the zoom area. You can select the zoom functions from a popup menu. Sections of the graph can be enlarged or reduced.

When you have selected the Zoom function, you can use the mouse to define the zoom area in the display.

- **Opens the selection window**
- **Enlarges the highlighted area in the X and Y directions**
- **Enlarges the highlighted area in the X direction only**
- **Enlarges the highlighted area in the Y direction only**
- **Cancels the last zoom operation and resets the graph to the previous setting**
- **Enlarges the graph in the X and Y direction at the highlighted position**
  - If you hold the mouse button down at a particular point, the graph continues to be enlarged until you release the button again.
- **Reduces the graph in the X and Y direction at the highlighted position**
  - If you hold the mouse button down at a particular point, the graph continues to be reduced about this point until you release the button again.
- **Resets the zoom area**
S
Samples, adapt ........................................ 5-32
Save ....................................................... 6-40
Save As ............................................... 6-40
Scaling .................................................... 8-55
Segment
  adapting the samples ............................ 5-32
  displaying the parameters ..................... 5-31
  new ..................................................... 5-30
  structure ........................................... 5-30
Segment to Point ..................................... 7-44
Segment, edit ......................................... 3-17
Shortcuts (overview) .................................. 4-23
Single Component ................................... 8-53
Single Segment ....................................... 8-53
Starting help ......................................... 9-56
Switching menu ...................................... 4-22

U
Uninstalling (program) .............................. 2-15

V
Vector format parameters, set ..................... 3-18

W
Waveform
  configure ........................................... 5-26
  converting Formats .............................. 7-44
  display ............................................. 10-57
  displaying the parameters ........................... 5-29
  edit ................................................. 3-16, 7-42
  structure ........................................ 5-25
Waveform to Point .................................. 7-44

X
X-Scale ................................................... 8-55

Z
Zero Line ............................................... 8-55
Zoom settings ........................................ 10-59